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    Introduction


    Existant depuis plus de cinq décennies, mais essentiellement ancré dans l'industrie, le prototypage a évolué vers la technologie de l'impression 3D. Elle se voit de plus en plus vulgarisée avec l'apparition d'imprimantes 3D libre de source sur le marché . Il est donc effectivement possible de se procurer les plans d'une imprimante sous licence libre dans le but de la reproduire ou de s'en inspirer pour en faire un modèle personnalisé.


    Les objets 3D peuvent être conçus par nombre de logiciels de modélisation à travers un long procédé. Ce processus de prototypage se trouve accéléré en se tournant vers le logiciel Blender.


    Blender est un modeleur surfacique à l'instar de Wings3D, Modo, Cinema4D, XSI, 3DSmax, Maya, plutôt que paramétrique ou volumique comme FreeCAD, SolidWorks, Catia et Solid Edge entre autres.


    Structuré en trois grandes parties, ce livre s'adresse aux utilisateurs qui modélisent des objets avec Blender ou qui récupèrent des objets issus d'autres logiciels en vue de les imprimer.


    Une première partie intitulée "Créer dans Blender" permet au lecteur de pouvoir appréhender la méthodologie de création dans Blender et de pouvoir le prendre en main afin de réaliser un objet concret.


    La deuxième partie nommée "Importer et modifier dans Blender" renseigne sur les étapes à suivre concernant l'importation de fichiers 2D ou 3D avec Blender, de même que leur modification.


    La troisième partie; "Exporter pour l'impression 3D" met la lumière sur les diverses tâches à effectuer sur un maillage de sorte à effectuer son exportation pour l'impression.


    Dans l'optique de suivre et de répliquer aisément les exemples montrés dans le livre, il est préférable de garder l'interface de Blender en anglais.

  


  
    A propos


    Cet ouvrage a été réalisé durant un libérathon* qui s'est tenu sur quatre jours à Rennes; du 30 novembre au 3 décembre 2013. Initié et soutenu par l'Organisation Internationale de la Francophonie (OIF*), ce libérathon a connu la participation des co-rédacteurs suivants:
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      	Ronan Ducluzeau, graphiste et formateur ;


      	Edddy Gautier, organisateur d'ateliers sur les logiciels 3D libres et membre actif du BUGParis* ;


      	John Lejeune, coordinateur du labfab de Rennes ;


      	Cédric Gémy, graphiste et formateur ;



      	Alexandre Penaud, étudiant en Sciences de l'Éducation ;



      	Kossigan Roland Assilevi, Ingénieur Informaticien et facilitateur ;



      	Elisa de Castro Guerra, graphiste, formatrice et facilitatrice.

    


    Un livre vivant


    N'hésitez pas à participer à cet ouvrage !


    Faites-nous part de vos commentaires dans la liste de diffusion de Flossmanuals francophone. Si vous avez des talents de rédacteur et une bonne connaissance des sujets abordés, vous êtes les bienvenus en tant que contributeur. Inscrivez-vous pour enrichir les contenus et/ ou créer de nouveaux chapitres.


    Ce livre libre est disponible sous plusieurs formats et supports : en ligne, en html, au format pdf ou epub et en livre imprimé.


    Publié sous licence G.P.L., ce livre peut être lu, copié et distribué librement sous les mêmes conditions.


    Vous consultez l'ouvrage publié le 7 décembre 2013.


    La version de Blender utilisée pour les exercices est la 2.69. La plupart des outils pour l'impression 3D sont apparus dans la version 2.67. Cependant, certains outils de modélisation utilisés dans les exercices sont plus récents. Il est donc déconseillé de suivre le livre sur une version antérieure à la 2.69.

Les mots suivis d'un astérisque (*) sont décrits dans le glossaire en fin d'ouvrage.
  


  
    Méthodologie


    L'impression 3D demande de la patience et de la persévérance. Chaque étape du processus requiert quelques heures de travail pour aboutir à un résultat satisfaisant. Afin de vous éviter la déconvenue de repartir plusieurs fois de zéro, ne lésinez pas sur les étapes de vérifications et de surveillance.


    Avant même d'ouvrir Blender, dans le cas d'un processus créatif ou de la reproduction d'une pièce existante, commencez par coucher votre idée sur papier.


    Plus vous aurez précisé votre projet, plus vous réduirez les voies d'abord. Il y a toujours différentes façons d'arriver à une forme. Choisir la plus rapide n'est souvent qu'une question de culture et d'expérience. Si vous avez besoin d'aide, vous serez plus à même de l'expliquer à quelqu'un de plus expérimenté, capable de vous aiguiller.


    Une fois votre imprimante correctement calibrée ou les renseignements sur le service d'impression collectés, le processus de production se déroule selon les grandes sections du livre. Soit vous créez de zéro votre forme, soit vous partez d'un fichier existant à modifier. Puis vous évaluez que sa géométrie respecte des contraintes d'impression. Et enfin, vous pouvez l'imprimer.


    La durée de l'impression est dépendante du matériel et est difficilement réductible sans diminuer la qualité du modèle. Alors que la méthodologie de création du modèle peut prendre de plusieurs heures à quelques dizaines de minutes en fonction de vos connaissances de Blender.


    En cas de blocage ou d'échec, identifiez le problème et persévérez. Si vous ne trouvez pas la cause du problème vous-même, demandez de l'aide, soit dans les forums d'entraide sur internet, soit dans un FabLab près de chez vous. Plus vous pratiquerez la modélisation avec Blender, plus vous serez à l'aise avec la réalisation de vos propres projets. Il suffit souvent de quelques semaines de tutoriels pour lever l'appréhension des débutants. Le manuel vous laisse entrapercevoir des cas pratiques simples et vous donne déjà de solides bases pour vous en éloigner un peu.


    Pour aller plus loin, vous trouverez des tutoriels en français sur http://www.blenderlounge.fr et http://www.etude-blender.fr/ ou de l'aide sur le forum http://blenderclan.tuxfamily.org

  


  
    Créer un premier objet


    En tant que suite 3D complète, Blender permet de créer des objets 3D à partir de zéro. Il regorge d'outils permettant de réaliser tout type de formes. On distingue plusieurs types d'objets 3D gérés par Blender pour différents usages (l'impression 3D, mais aussi le jeu vidéo, les illustrations ou les films d'animation, etc.). Parmi tous ces types d'objets, il y a 3 principales catégories permettant de produire de la géométrie:les surfaces NURBS, les courbes de Bézier et les maillages (Mesh). Quelle que soit la catégorie utilisée comme point de départ de votre création, celle-ci doit toujours aboutir (être convertie) en un objet de type maillage pour l'impression 3D.


    L'édition d'un maillage dans Blender est aussi plus généralement appelée modélisation polygonale.


    
      La modélisation est un vaste sujet. Le chapitre du wiki officiel est assez complet en anglais mais n'est pas traduit en françaishttp://wiki.blender.org/index.php/Doc:2.6/Manual. Cependant, comme il s'agit d'une étape primordiale pour la plupart des travaux en 3D. Elle est traitée dans la majorité des tutoriels disponibles sur internet.
    


    Afin d'appréhender quelques outils de la modélisation polygonale dans Blender, voici un didacticiel pas à pas pour créer un badge portant un prénom.
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    Premièrement, vous allez créer le support ovale du texte. Dans un fichier vierge, passez la vue 3D en vue de dessus [NumPad 7]. Si votre fichier de base contient un cube, sélectionnez le d'un clic droit [RMB] et [x]. Quittez la vue perspective pour une vue orthographique [NumPad 5]. Grâce au menu Add [Maj A >Mesh>Cylinder], ajoutez un cylindre avec les paramètres suivants que vous pouvez saisir dans le bas de la boîte à outils sur la gauche de la vue 3D ou en appuyant sur F6 : nombre de sommets [Vertices] 64, rayon [Radius] 1, profondeur [Depth] 0.3, mode de fermeture des extrémités [Cap Fill] Type Ngon.
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    Pour modifier la largeur de l'objet, faire une mise à l'échelle contrainte sur l'axe X avec l'outil Scale en tapant la suite [S X 2 Entrée].


    À présent, il faut ajouter une petite partie trouée qui permettra la fixation du badge par le biais d'un fil ou de tout autre type d'attache.


    Basculez en mode Édition avec [Tab].


    Ajoutez un cylindre [Maj A>Mesh>Cylinder] avec les réglages [Vertices] 16, [Radius] 0.15, [Depth] 0.3, [Cap Fill] Type Nothing, [Location] X 0.345, Y 1.3, Z 0.
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    Extrudez les faces sélectionnées du petit cylindre [E] et sans déplacer la souris sortez de la fonction en utilisant un clic droit ou [Echap]. Nous avons alors créé des faces qui sont positionnées par-dessus leurs originales.


    Élargissons les faces extrudées en faisant une mise à l'échelle de la sélection [S], contrainte dans le plan XY [Maj Z 2] .


    Passez en mode de sélection de faces [Ctrl TAB] et en visualisation fil de fer [Z]. Avec la combinaison de [Ctrl] et du clic gauche, sélectionnez 3 faces sur chaque partie, la petite et la grande, l'une en regard de l'autre; et n'hésitez pas à zoomer avec la molette pour gagner en précision.Puis supprimez les avec [X] et sélectionnez [faces].
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    Tournez la vue autour de l'objet en déplaçant la souris et en maintenant la molette enfoncée, observez le résultat. Repassez en mode sélection de vertices [ctrl TAB>Vertex].
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    Activez les boutons de l'accrochage Snap (aimant) et de fusion automatique des vertices [Automerge Editing] (double flèche) dans la barre de l'en-tête de la vue 3D.
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    Pour fusionner les vertices des deux formes, déplacez-les un à un [G] pour joindre les vertices de l'ouverture du petit cylindre et ceux de l'ouverture du grand cylindre. Pour vous aider, souvenez-vous que le magnétisme de l'aimant est calculé par rapport à la position de la souris, et non celle du point en déplacement. Blender entoure d'un petit rond les points qu'il est prêt à fusionner : vous pouvez alors valider d'un clic gauche si la position est bonne.
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    À partir de ce moment, le magnétisme peut être désactivé. En mode de sélection de face [Ctrl TAB>faces], sélectionnez la face supérieure du badge d'un clic gauche et supprimez-la [x>Faces].


    Le maillage est alors ouvert. Les arêtes de l'ouverture sont alors qualifiées d'edges non manifold, c'est-à-dire qu'il peut y avoir pour Blender une indécision à savoir si certaines faces sont à l'intérieur ou à l'extérieur.


    Passez en mode sélection d'arêtes [Ctrl TAB Edge] pour sélectionner les arêtes de l'ouverture avec le menu [Select>Non manifold] ou [Maj Ctrl Alt M].
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    Afin de refermer le maillage, utilisez la recherche [barre espace] pour appeler l'outil Grid fill (span 16). Activez l'option Simple Blending pour un peu plus homogénéiser la taille des faces créées par le Grid Fill. Modifiez le paramètre offset si besoin pour aligner les arêtes de la grille créée.


    
      Le Grid Fill est un outil apparu dans la version 2.68. Il ne permettait alors que de joindre 2 boucles d'arêtes et non pas de remplir un trou. Dans la 2.68, il aurait fallu désélectionner 2 edges face à face pour changer la sélection du edge loop en 2 edge loops constitués du même nombre d'edges.

    


    [image: ]


    Basculez en mode objet [TAB] et ajoutez un objet texte [Maj A > Text] à la position [location] X=0, Y=-0.2 , Z=1


    Dans les propriétés du texte (icône du F), dans l'encart [Align] du panneau [Paragraph], cliquez sur le bouton [Center] pour centrer le texte au-dessus du support à partir de son point d'origine.
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    Passez l'objet texte en mode Édition [TAB] puis écrivez au clavier le nom ou prénom de votre choix. Repassez en mode objet [TAB] et étendez la sélection d'objets au maillage en faisant Clic droit + [Maj] enfoncé. Le maillage devient l'objet actif. Nous allons repasser une nouvelle fois en mode Édition [TAB] et, en vue de dessus [NumPad 7], utiliser la recherche [barre espace] pour appeler l'outil [Knife Project]. Cet outil permet de découper le maillage existant pour y insérer des faces correspondant à la projection du texte suivant la vue. Le texte n'a donc pas besoin de toucher la forme du médaillon, mais il est important que les deux soient superposés dans la vue.
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    Extrudez les faces présélectionnées du texte [E] d'une valeur 0.15.
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    Repassez finalement en mode objet.


    Et voilà pour la réalisation d'un modèle 3d complet. Il ne vous reste plus qu'à le soumettre aux vérifications d'usage d'un export pour une impression 3D.


    Ici, l'exemple concerne un texte mais le Knife Project est également fonctionnel avec les objets courbes abordés dans le chapitre Importer un modèle 2D. La même démarche est donc reproductible pour un logo.


  


  
    Donner une épaisseur


    Les formes créées dans Blender n'ont par défaut aucune épaisseur. Les faces sont plates et les arêtes sont sans "matière". Aussi il va être important de définir cette propriété de manière à ce que l'imprimante puisse savoir quelle quantité de matière associer à la surface. Dans Blender, cela passera par le modificateur Solidify pour les faces, ou Skin pour les arêtes.


    Épaissir une face avec Solidify


    Dans l'exemple suivant, nous allons créer un mug. Il s'agit d'un objet relativement simple à modéliser à partir de zéro. C'est aussi objet de base de l'impression 3D.


    Il y a plusieurs méthodes pour réaliser un objet de ce type:nous utiliserons ici volontairement le spin qui permettra de dessiner l'ensemble de notre mug en se basant sur un profil simple à partir duquel les faces seront générées. Cette méthode pourra être utilisée pour tout objet de ce type (tasse, vase, verre, plats..).


    Dans un nouveau fichier, supprimons le cube par défaut [x] et partons d'un simple plan [Maj A][Mesh][Plane].


    Appuyez sur [tab] pour passer en mode Édition, sélectionnez trois vertex avec le clic droit [RMB] et supprimez-les avec la touche [x].


    Il reste alors un seul vertex que vous pouvez placer au centre de la scène avec le menu Snap [Maj S][Selection to cursor]. Si le vertex est mal placé, c'est certainement qu'un clic gauche malencontreux a déplacé votre curseur 3D. Vous pouvez le rétablir à l'aide de [Maj C] et retourner dans le menu Snap ou définir les positions X et Y du vertex à 0 dans la partie supérieure de la fenêtre Propriétés [N].


    Passez alors en vue de face [NumPad 1] ou [View>Front] et extrudez le vertex jusqu'à obtenir la moitié de la silhouette:Touche [E] pour extruder, puis [G] pour déplacer, autant que nécessaire en donnant le profil qui vous plaît. Pour vous aider à être plus précis, passez éventuellement en vue Orthographique [View>Persp/Ortho] ou [NumPad 5].


    [image: Profil du Mug par extrusion dans Blender]


    Nous allons maintenant créer les faces à partir de ce profil. Nous allons à présent utiliser la fonction Spin qui est appliquée en fonction de la vue. Passez en vue de dessus [NumPad 7] pour faciliter la répétition. Toujours en mode Edit, sélectionnez tous les vertex [A].


    Dans la ToolBox [T], cliquez sur le bouton [Spin] dans le groupe [Add]. Une première répétition par défaut s'effectue. En bas de la boîte à outils, les paramètres du Spin sont apparus:notez par exemple 18 en [Steps] et surtout 360 en [Degrees] de manière à ce que nous ayons bien un tour complet.


    [image: Placement au-dessus du profil]


    [image: Application du Spin dans Blender]


    [image: Paramétrage du Spin pour un tour complet]


    Nous avons alors une superposition de vertex au niveau du raccord de notre profil. Sélectionnez l'ensemble des vertex de l'objet [A][A], puis [w][Remove Doubles]. Blender affiche temporairement le nombre de vertices supprimés dans la barre de menu.


    Tournez maintenant librement autour de votre objet pour l'observer ou l'adapter ici ou là.


    [image: Résultat de la fonction Spin]


    Pour ajouter un peu de précision à notre maillage, utilisons le modificateur [Subdivision Surface], souvent abrégé en SubSurf, placé dans la seconde colonne [Generate]. Le réglage [View] mentionne 1 et [Render] 2. Le réglage de rendu n'est pas utilisé dans la vue 3D. En général [View] est inférieur pour permettre une plus grande rapidité des calculs lors de la phase de modélisation. Dans notre cas, nous allons l'augmenter à la fois pour mieux voir le résultat final, mais aussi pour préserver cet aspect lors de l'export en STL pour l'impression.


    [image: Subdivision de Surface pour affiner le modèle]


    Maintenant que notre objet est réalisé, nous pouvons lui appliquer le modificateur [Solidify] placé juste au-dessus de SubSurf. Les réglages sur lesquels porter notre attention sont les suivants :


    
      	[Thickness] pour définir l'épaisseur en tant que telle. S'il n'y a pas de limite maximale, il nous semble cependant important de faire attention à l'épaisseur minimale qui ne doit pas être inférieure à la finesse d'impression de votre imprimante 3D.


      	Les réglages [Crease] donnent des précisions sur le positionnement et l'angularité des extrémités. Si votre extrémité vous semble trop plate, vous pouvez inverser l'ordre des modificateurs en cliquant sur les petites flèches triangulaires placées à droite de la fenêtre du modificateur.


      	[Even Thickness] va rendre constante l'épaisseur sur toute la surface. Elle n'est pas nécessaire, mais peut éviter des mauvaises surprises dans les objets à formes complexes qui risqueraient alors d'avoir des zones trop peu épaisses.


      	[Fill Rim] est coché par défaut. Il sert à fermer l'épaisseur avec une face.


      	Le réglage [Clamp] permet de serrer ou desserrer la solidification en relation avec l'Offset. Jouer sur ce paramètre permet d'éviter certains problèmes d'intersection comme il sera vue au chapitre Nettoyer son maillage.

    


    [image: Application du solidify]


    [image: Effet du Fill Rim dans Solidify]


    [image: Effet du Inner dans Solidify]


    [image: Effet du Outer dans Solidify]


    [image: Effet du Rim dans Solidify]


    Une fois imprimé, voilà le résultat.
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    Skin


    Si votre objet est plutôt constitué d’arêtes ou que ses faces ne vous intéressent pas dans le cadre de votre impression, le modificateur Skin permet d'obtenir un résultat intéressant en donnant une épaisseur. Voici un exemple simple pour illustrer son utilisation en construisant une structure filaire à base d'une sphère.


    Pour commencer, ajoutez une icosphere [Maj A>Mesh>Icosphere]. Vous pouvez modifier le nombre de subdivisions ainsi que sa taille dans les options de la boîte à outils. Ici, notre taille est de 10.
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    Allez à présent dans le panneau des modificateurs et ajoutez un [Skin], placez dans la colonne [Generate], au-dessus de [Solidify], vu précédemment. Immédiatement, vos faces disparaissent et vos arêtes prennent du relief.
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    En mode Edit [TAB], appuyez sur [Ctrl A] et éloignez ou approchez la souris pour modifier l'épaisseur des branches. Pour plus de précisions, vous pouvez aussi utiliser les réglages [Vector] dans le panneau [Skin Resize] de la boîte à outils.
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    Le résultat est très anguleux. Vous pouvez utiliser le modificateur Subdivision de Surface pour affiner les faces. Vus pouvez aussi appliquer des épaisseurs différentes en appliquant l'option Skin Resize [Ctrl A] à une sélection.
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    En allant sur ce lien http://www.blendernation.com/2011/03/11/skin-modifier-development ; vous découvrirez un petit exemple du développeur de la fonctionnalité Skin, montrant un résultat sympathique et un peu différent.
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      Le modificateur est une solution très intéressante parce qu'elle facilite la retouche de l'objet. Vous pouvez cependant arriver à un résultat de ce type en mode Edit; en appuyant sur la barre espace, écrivez Wire et activez l'option Wire Frame sélectionnée.
    

  


  
    Importer un modèle 3D


    Nous allons prendre l'exemple d'un fichier au format STL (une voiture récupérée sur http://www.thingiverse.com/thing:45449)


    Après extraction de l'archive récupérée dans le dossier de votre choix, doit apparaître un (ou des fichiers) au format STL. Ce sont les modèles 3D.



    Pour importer un modèle 3D (au format STL), il faut donc se rendre dans le menu d'import [File>Import] et choisir [Stl (.stl)] :


    [image: menu import stl]


    Naviguez alors dans vos dossiers jusqu'à votre fichier STL présent sur votre ordinateur et sélectionnez-le par un double-clic.


    Voilà, le fichier est importé dans Blender !


    [image: ]


    Lors de l'importation d'un modèle 3D, il se peut qu'il ne soit pas visible dans sa globalité. Ceci est dû à la taille de l'objet qui est trop grande ou trop petite par rapport à votre vue par défaut dans Blender.


    Voilà le résultat après avoir divisé par 10 la taille de l'objet en tapant la [touche S] et la valeur 0.1.


    [image: ]



    

    Chaque logiciel 3D a ses propres préférences en matière d'unités de mesure.

    Un architecte préférera travailler sur un logiciel où l'unité de base sera le centimètre ou le mètre.

    Alors que l'utilisateur d'une imprimante 3D préférera des mesures exprimées en millimètres.

    Par défaut, Blender utilise un système de mesure arbitraire.

    Il faut donc s'attendre à ce que, suivant la provenance du modèle importé, la correspondance soit de 1 unité soit égale à 1 mm ou à 1m.


    Le panneau [Units] des propriétés de la scène règle l'affichage des unités dans l'interface. Les valeurs de dimensions dans les différents champs s'accompagnent alors d'une abréviation marquant l'unité utilisée de manière à éviter toute confusion. 
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    Au lieu de valeurs avec une décimale, exprimée selon une seule unité; la case [Separate Units] permet d'afficher les sous-unités.

    Passer la valeur [Scale] dans le panneau [Units] modifie l'échelle générale de toute la scène. Dans cet exemple, en notant 0.01, cela revient à changer les mètres en centimètres et les décimètres en millimètres sans pour autant avoir besoin d'agir sur les unités elles-mêmes.


    La voiture importée mesure en longueur en Object Mode 10m 8,2cm de long.

    Cependant, si on la mesure en Edit Mode : la valeur indiquée correspond à 100m 82cm.
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    Cela est dû à la mise à l'échelle en Object Mode. Elle ne modifie en rien les données locales du maillage mais les données de l'objet utilisant ce maillage dans la scène.


    Blender est un logiciel dont les applications ne se limitent pas à l'impression 3D. Pour un jeu ou une animation, il peut être intéressant de partager les mêmes données de maillage entre différents objets à différentes échelles.

    Afin de garder une cohérence entre les données locales en Edit mode et les données globales en Object mode, observez deux règles simples :


    
      	Règle 1 : Ne jamais faire de mise à l'échelle en Object mode mais toujours en Edit mode.


      	Règle 2 : Si la règle 1 n' pas été respectée ; en Objet mode, réinitialiser l'échelle avec la combinaison [Ctrl A > Apply Scale].

    


    Pour plus de simplicité, il est préférable de ne pas utiliser le panneau [Units], de conserver toutes les valeurs d'échelle [Scale] à 1 et de considérer l'unité arbitraire de Blender comme unité pertinente.


    Lorsqu'un dessinateur veut représenter ce qu'il voit; il va utiliser son crayon et son pouce pour prendre des mesures relatives. Pour représenter quelque chose de reconnaissable, il faut essayer de respecter ses proportions. Pour une voiture de 1,5 mètre de large, si le rétroviseur fait 15 cm de long; il suffit de conserver un rapport de 10 en unités blender entre la taille de la voiture et celle du rétroviseur pour que le modèle reste reconnaissable.

    Il en ira de même pour tout ce que vous souhaiterez représenter fidèlement.


    

    Pour l'impression 3D, considérez les valeurs affichées comme exprimées en millimètres au moment de l'export.

  


  
    Quelques exemples de modèles 3D


    Les domaines d'application de l'impression 3D sont aussi immenses que variés; les objets 3D modélisés et imprimés n'ayant que pour seule limite la créativité de leurs auteurs. Ce chapitre, loin d'être exhaustif, met en exergue quelques modèles que vous retrouverez probablement sur le Net.


    Tout comme la plupart des outils numériques, ceux-ci se sont répandus un peu partout et impactent un large éventail de professions. Que vous soyez architecte, designer, graphiste, prothésiste, artiste, médecin, enseignant ou bien chercheur, maquettiste ou simplement passionné, adolescent ou retraité, qu'il s'agisse de biologie, d'architecture, de science et de mécanique, vous trouverez à coup sûr une application pratique de l'impression 3D à votre domaine de prédilection.


    C'est dans la catégorie des figurines, jeux, jouets et objets amusants ou improbables que vous trouverez le plus d'exemples.



    [image: ]



    Cette figurine d'écureuil par DanielFC10 est disponible au téléchargement sur le site blendswap.com. Conçue à l'origine pour le rendu 3D, elle n'est pas encore préparée pour l'impression 3D. Mais grâce a cet ouvrage, vous ne devriez plus tarder à pouvoir préparer un tel fichier pour l'impression.


    


    Il existe aussi des dépôts où vous trouverez des fichiers plus orientés vers l'impression direct des modèles 3D. Par exemple youmagine.org d'où provient l'exemple ci-après.



    [image: Une vue topographique du mont Jendemsfjellet, Norvège]


    Une vue topographique du mont Jendemsfjellet, en Norvège. Ce modèle sous licence CC-BY provient du site youmagine.org



    


    Le plus connu de tous ces dépôts reste pour l'instant thingiverse.com. C'est actuellement là que vous trouverez le plus de catégories disponibles et de modèles imprimables.



    [image: ]


    Un modèle de charpente trouvée sur thingiverse.com. Cette structure à la saveur Voronoï est sous licence CC-BY-SA.


    


    Quelque soit votre source, notez bien que les fichiers proposé par la communauté d'utilisateurs ne sont pas toujours "prêt à cuire". Il faudra parfois les modifier à votre goût ou selon vos besoins. Vous trouverez parfois des fichiers fournis bruts, dans un format souvent propriétaire ou exotique, qu'il vous faudra convertir avant de pouvoir l'importer dans Blender.



    


  


  
    Modifier un maillage existant


    Vous avez importé un fichier en vue de l'imprimer. Cependant, l'objet n'est pas complètement satisfaisant pour votre projet d'impression. Vous souhaiteriez lui apporter quelques modifications. Ce chapitre est consacré à la réalisation de 2 modifications courantes, à savoir, la séparation d'un objet en vue d'en conserver qu'une partie et la personnalisation d'un maillage au moyen du Sculpt mode.


    Séparer un maillage


    Pour cet exemple, une voiture téléchargée depuis le site Thingiverse servira de modèle. Le but est de lui en extraire une roue. http://www.thingiverse.com/thing:45449


    [image: La voiture présente sur Thinkgiverse qui servira dexemple]


    Seule la roue de ce modèle est utile. Comme ce fichier contient plusieurs pièces, il faut l'éditer pour extraire la roue du reste du maillage.


    Dans un premier temps, il faut importer le modèle car_thingi.stldans Blender via File > Import > Stl (.stl)


    [image: Importer un fichier STL avec Blender]


    Le modèle est très grand. Vous aurez besoin de dé-zoomer pour avoir une vue globale. Puis passez en Edit mode, touche [TAB].


    [image: Passer en mode édition avec Blender]


    [image: Passer en mode édition avec Blender]


    L’intégralité du maillage sera sélectionné, désélectionnez-le avec [A] puis mettez le pointeur de la souris sur la pièce intéressante et appuyez sur [L] pour sélectionner tous les vertex reliés par les arêtes.


    [image: Sélectionner toutes les arrêtes avec Blender]


    Enfin pour l'extraire du reste, appuyez sur [P] et choisissez [Selection] dans le menu Separate.


    
      Si vous choisissez [By loose parts], ce ne sera pas que la zone survolée qui sera séparée, mais toutes les parties qui ne seront pas rattachées à une autre. Cette méthode peut être plus rapide si vous avez plusieurs objets à séparer.
    


    [image: Choisir la sélection avec Blender]


    Pour terminer, sortez de l'Edit mode [TAB]. La roue est désormais dans un objet séparé. Il ne restera plus qu'à l'exporter.


    Modifier le maillage avec Sculpt mode


    Pour certains fichiers, il sera nécessaire de faire une vraie retouche du maillage. C'est le cas en particulier, de ceux qui proviennent d'un scan 3D. Si l'édition peut se faire avec les outils habituels de sélection de faces, arêtes et vertex, cela peut cependant s'avérer fastidieux.


    Pour cet exemple, il s'agira de partir d'un maillage représentant une pintade [pintade.stl]. Cette pintade mérite des modifications en vue d'une impression de meilleure qualité, plus spécialement au niveau du socle et de la tête.


    [image: la Pintade.stl]


    Pour nettoyer ce modèle et lui ajouter quelques détails, le module de sculpture (Sculpt mode) est certainement le plus approprié. Il va s'agir d'utiliser une série d'outils qui modifieront le maillage avec des options variées, se comportant un peu comme des doigts sur une pâte à modeler.


    Comme précédemment, il faut commencer par importer le fichier STL, puis passer en Sculpt mode :


    [image: sculpt mode avec Blender]


    Pour que ce module fonctionne correctement, il faut désactiver [Double Sided] dans les propriétés [Normals] du maillage.


    [image: ]



    Ce mode dispose d'un choix de pinceaux varié. La tablette graphique est fortement recommandée pour utiliser ces pinceaux afin de profiter des variations de pression fort utile pour ce genre d'exercice. Mais si vous disposez d'une souris, cela fera l'affaire.


    Parmi les options intéressantes et utiles des brosses disponibles en Sculpt mode, le mode dynamique permettra d'ajouter des vertex selon une résolution définie. L'activer permet d'utiliser la brosse comme un véritable outil d'édition de maillage. Il est disponible mais il est désactivé par défaut. Pour l'activer, passez par le panneau [Tools] et cliquez sur le bouton (Enable Dynamic] de la partie [Topology].


    [image: mode dynamique paint dans Blender]


    La résolution sera gérée avec le réglage [Detail Size]. Plus ce chiffre sera élevé, moins la résolution est fine. Par défaut, la résolution est à 30 ce qui est bien pour commencer. L'option [Smooth Shading] gomme les angles, il est déconseillé de l'activer pour l'impression 3D.


    Afin d'ajouter des détails, il va aussi falloir choisir le type de brosse. Celles-ci correspondent à des types d'action ou de résultats attendus. On accède à la liste des brosses en cliquant sur l'aperçu tout en haut du panneau [Tools]. Choisissez le pinceau [Crease] qui permettra d'accentuer les angles.


    [image: pinceaux sculpt mode Blender]


    Avec le Clic gauche, ce pinceau dessine des creux en resserrant le maillage, et Clic gauche + [Ctrl] affirme les arêtes. Cela sera très utile pour affiner le bec et y mettre les reliefs manquants.


    [image: Sculpt mode en action dans Blender]


    Avec [Maj] le pinceau passe en smooth, ce qui permet d'effacer les angles et de détendre le maillage en le rendant plus régulier. Jouez le cas échéant avec la dimension de l'outil en modifiant le réglage [radius].


    Le travail sur la pintade terminée, il est temps de s'occuper du socle sur lequel elle tiendra. Dans un premier temps, supprimez le socle actuel pour le remplacer par quelque chose de plus propre. Repassez en Edit mode [Tab] et avec le pinceau de sélection [C], sélectionnez tous les vertex du socle.


    [image: Selection des vertex Blender]


    Avec le pinceau de sélection, le bouton gauche sélectionne, et celui du milieu désélectionne, alors que la molette change la taille du pinceau. Pour confirmer la sélection, il faudra utiliser le clic droit. Comme il est impossible de déplacer la vue pendant la sélection, l'opération devra être réalisée en plusieurs fois afin d'avoir tous les vertex du socle de sélectionnés. Dans ce cas, appuyez sur [Echap] pour sortir de l'outil et vous déplacer dans la vue, puis réactivez le [C].


    Effacer ces vertex [X > vertex] puis refermez les pattes en créant des faces [F] après les avoir sélectionnés par exemple avec [Select>Edge Loop] sur la base d'une première arête (l'addon F2 est très utile pour ce genre de travail). Si certains vertex n'étaient pas sélectionnés, recommencez jusqu'à suppression complète du socle.


    [image: Effacer des Vertex dans Blender]


    Afin de ne pas faire ce travail fastidieux deux fois, l'astuce ici est d'effacer la patte de gauche pour la remplacer par une copie de celle de droite. Sélectionnez les vertex de la patte gauche pour les effacer sans crainte. Sélectionnez la patte de droite pour la dupliquer [Maj D>Entrée]. Pour respecter la symétrie du corps, appliquez un miroir sur l'axe des Y [Ctrl+M>Y>Entrée] et placez cette patte à l'endroit désiré.


    [image: Appliquer un miroir dans Blender]


    Pour joindre cette patte au corps, sélectionner les deux extrémités de chaque avec Alt+Clic droit puis Alt+Maj+Clic droit.


    [image: Créer un bridge dans Blender]


    Il s'agit maintenant de créer un bridge pour attacher le corps à la patte [W > bridge edge loops. Une fois raccordé, un dernier retour en Sculpt mode est nécessaire pour unifier la modélisation et passer quelques coups de brosse smooth.


    La queue est actuellement assez longue et il faudra soit la raccourcir soit fabriquer un échafaudage pour la supporter (voir chapitre dédié en section 3). Pour éviter d'ajouter les supports d'impression, les brosses Grab et Fill du Sculpt mode vous aideront à redresser la queue vers le haut.


    [image: Brosse Grab et Fill dans Blender]


    Pendant cette phase il est utile de faire des allers et retours en Edit mode [TAB] afin d'utiliser l'outil de visualisation "Mesh Analysis", pour vérifier l'angle des faces (type Overhang). L'angle par défaut est de 45°, ce qui est parfait, mais des modifications sont possibles en connaissance de cause.


    [image: Mesh Analysis Blender]


    Repassez en mode Objet [TAB] pour ajouter le socle, appuyer sur [Maj A], ajoutez un cube, puis en Edit mode, mettez-le aux dimensions souhaitées et retournez en Object mode.


    Une fois placée à l'endroit désiré, sélectionnez la pintade et ajouter un modificateur [Boolean] en opération [Union]. Cliquez sur la zone Object pour faire apparaître la liste des objets de la scène et choisissez le cube comme cible. La pintade est maintenant unie au socle.


    [image: pintade finale]


    Il ne reste plus qu'à exporter l'objet au format STL et l'imprimer (avec des échaffaudages).


    [image: ]

  


  
    Analyser son maillage


    Blender dispose de deux outils d'analyse de maillage destinés à l'impression 3D : Mesh Analysis et 3D Printing Toolbox. Ces deux fenêtres ont quelques paramètres identiques, mais la première est la plus simple à prendre en main.


    Le mode de visualisation "Mesh Analysis"


    Le panneau d'analyse de maillage est disponible en mode Édition dans les propriétés [N] avec un affichage solid.


    [image: ]


    [image: ]

    

    Cet onglet permet d'activer différents types d'analyse du modèle en mode Édition.

    N'étant pas compatible avec les modificateurs, vous devez soit désactiver vos modificateurs mais dans ce cas leur action sur le maillage ne sera prise en compte, soit les appliquer (clic sur le bouton [Apply] dans la fenêtre de chacun des modificateurs).


    Il colore les faces incriminées de variations de couleurs allant de bleu à rouge selon les limites configurées.

    Il dispose de 5 types d'analyse:



    
      	Overhang


      	permet de visualiser les faces dépassant l'angle paramétré par rapport au sol, afin de réaliser des modèles avec le moins de supports nécessaires; dans le cas du mug, les parties sortant de la forme de base, bec et anse, posent clairement problème.

      [image: ]



      	Thickness


      	met en évidence les faces dont l'épaisseur peut poser problème. Il s'agira de paramétrer le minimum et le maximum d'épaisseur selon les besoins définis à l'impression et d'en anticiper les problèmes. Dans l'exemple, on peut voir que l'épaisseur est calculée selon l'orientation de la face. Ainsi, la face supérieure de la tasse est considérée comme épaisse au vu de toute la matière placée en dessous. En revanche, le bec, juste créé avec une arête déplacée manque réellement d'épaisseur. Il faut aussi avoir en tête que l'imprimante n'imprime pas nécessairement la totalité d'une épaisseur, par économie de matière première.

      [image: ]



      	Intersect


      	pour visualiser les faces qui se croiseraient; notre modèle par défaut ne contient pas de croisement de faces. mais cela pourrait être fréquent pour des objets plus complexes (modèles de personnages par exemple). Le singe par défaut de Blender est constitué de croisement au niveau des yeux.

      [image: ]



      	Distortion


      	affiche les faces non planes (un ngon* dont les vertices ne seraient pas sur le même plan); une fois encore, le bec et la base de l'anse constitue des zones de déformation à regarder avec attention au moment de l'impression. Il est important de bien noter les angles à analyser selon la résistance des matériaux utilisés et la capacité à supporter leur propre poids. Plus l'angle de déformation est élevé plus la difficulté à imprimer sera grande si la projection est volumineuse.

      [image: ]



      	Sharp


      	affiche les angles trop aigus. Ce seront des points à vérifier à l'impression parce que le taux de précision nécessaire et la fragilité peuvent impacter le résultat.

      [image: ]


    


    L'add-on 3D print toolbox


    Apparu dans la version 2.67 de Blender, cet add-on complète le panneau Mesh Analysis et permet d'avoir une vue plus globale de l'ensemble des problèmes.


    En cliquant sur le bouton relatif à un problème (celui qui contient le nom du test, par exemple Thickness). Le résultat d'analyse apparaît alors en bas avec le nombre de faces répondant au critère. Cliquez alors sur cette zone de résultat pour sélectionner automatiquement les faces.


    [image: ]
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      	Volume


      	calcule le volume de son objet.


      	Area


      	calcule la surface de son objet (utile pour les impressions céramiques où les prestataires calculent le prix par rapport à celle-ci).


      	Solid


      	indique si le maillage est "non manifold" (volume non fermé) et si les normals sont dans le bon sens, permet également de sélectionner automatiquement les vertex incriminés.


      	Intersections


      	indique si des faces se croisent.


      	Degenerate


      	met en évidence les faces qui feront une taille nulle, ce qui poserait des soucis sur certains logiciels.


      	Distorted


      	indique les faces non planes.


      	Thickness


      	indique les murs dont l'épaisseur est inférieure au paramètre saisi


      	Edge Sharp


      	montrant les angles trop aigus.


      	Overhang


      	pour les faces dont l'angle par rapport au sol est inférieur au paramètre.


      	Check All


      	pour faire une vérification sur tous les paramètres ci-dessus et peut constituer une première approche pratique pour faire une évaluation générale.


      	Isolated


      	supprime les vertex qui n'appartiennent pas à un volume et évitera d'imprimer des formes non nécessaires.


      	Distorted


      	pour supprimer les faces non planes


      	Scale to Volume


      	modifie l'échelle de l'objet afin de lui donner un volume précis


      	Scale to Bounds


      	modifie l'échelle de l'objet afin de lui donner une longueur maximum


      	Export Path


      	permet d'exporter l'objet sélectionné, les 2 boutons permettent d'appliquer l'échelle à l'export pour le premier et d'ajouter les mapping d'image dans le but des impressions en quadrichromie (Zprinter de chez Zcorp) pour le deuxième.

    


    3D Printing Toolbox complète admirablement [Mesh Analysis] :


    
      	contient plus d'options et affiche les quantités


      	travaille avec les modificateurs activés ce qui rend les corrections plus faciles, mais les résultats gagneront tout de même à être effectués sur des modificateurs appliqués


      	permet de sélectionner directement les faces


      	et aussi de fonctionner en mode filaire ce qui permet d'accéder à des éléments invisibles comme dans ce cas de l'[intersect] apparaissant à la base du mug qui n'était pas évident avec Mesh Analysis.

      [image: ]


    

  


  
    Nettoyer son maillage


    Afin d'avoir un modèle imprimable, il faut respecter quelques contraintes. Certaines de ces contraintes sont évidentes alors que pour d'autres un passage par les outils d'analyse sera pratique.


    Épaisseur 


    Respecter la taille minimum imprimable des murs, selon l'imprimante utilisée cette taille varie, en générale, il ne faut pas descendre sous les 0.8mm. Adaptez bien vos réglages d'échelle et vos unités dans la scène en fonction de l'échelle d'impression, car vous pourrez aussi créer un modèle plus petit que vous mettrez à l'échelle avec vos logiciels d'impression (même si cela ne simplifie pas la tâche).


    La solution consiste à utiliser l'add-on [3D Printing Toolbox] afin de voir les zones trop fines et soit agrandir la taille du modèle en général, soit augmenter l'épaisseur des parties incriminées en les déplaçant. Si vous avez utilisé le modificateur [Solidify], vérifiez le réglage [Thickness] et [Even thickness].


    Maillage ouvert (non-manifold)


    La présence d'ouverture par le biais de faces qui n'ont pas de voisine peut aussi être une difficulté. Il ne faut donc pas avoir de maillage "non manifold", c'est a dire de volume ouvert, comme un cube a 5 faces seulement par exemple .

    

    [image: ]

    

    La solution est de passer en mode Édition, dans le header de la vue 3D, menu [Mesh > Clean up > Fill Holes]. Si vous avez utilisé le modificateur [Solidify], vous limitez déjà ce risque mais contrôlez moins vos épaisseurs que modélisation par face mais vérifiez que l'option [Fill Rim] a bien été activée.


    Faces non planes


    Les faces non planes sont des faces considérées comme tordues. En général, elles sont dues au fait qu'un vertex n'est pas sur le même alignement que les autres. Cela arrive le plus souvent sur des faces quadratiques.


    Utiliser l'add-on [3D print toolbox] et son bouton cleanup [Distorted], ou en mode Édition, dans le header de la vue 3D, utilisez le menu [Mesh > Clean up > Split non-planar faces]. Blender va scinder la face en 2 de manière à tenir compte de l'orientation spécifique de ce vertex.


    [image: ]


    Nombre de faces trop important


    Dans le cas d'un scan ou d'un sculpt, le nombre de faces peut être trop élevé pour être géré par le logiciel de création de gcode (fichier de contrôle d'imprimante). C'est aussi le cas lorsque le modificateur de [Subdivision de surface] est utilisé abusivement sur des maillages contenant déjà un nombre de faces assez élevé.


    L'utilisation du modificateur [Decimate] permet de réduire efficacement ce problème en tentant de préserver la forme globale. Le réglage important est le [Ratio] : lorsqu'il est de 0, toutes les faces seront supprimées et lorsqu'il est à 1, le maillage n'est pas modifié. Il convient donc de trouver le meilleur paramètre en fonction du nombre souhaité.

    

    [image: ]


    Intersection de faces


    Les faces coupant d'autre faces sont à éradiquer. Cela est particulièrement vrai lorsque les faces ne sont pas dans la même orientation mais se coupent en créant un angle. Selon la taille de la zone d'intersection le résultat imprimé pourra être plus ou moins décevant.


    La solution est alors manuelle. Il faudra déplacer les vertex hors du volume d'intersection.


    Si un modificateur [Solidify] a été appliqué, vérifiez que la valeur du réglage [clamp] qui peut parfois engendrer ce type d'erreur si elle n'est pas adaptée au maillage. Ici avec un [clamp] à 2, une seule face est intersectée alors que la quantité passe à 145 si le [clamp] est à 0.
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    Vertices et faces isolés


    Les vertex isolés et les faces isolées sont à exclure sont souvent des restes oubliés ou encore des objets séparés. Dans le premier cas ils sont inutiles, dans le second, il faudra éventuellement séparer les objets comme vu au chapitre Importer des modèles 3D et les imprimer séparément.



    Pour supprimer les éléments oubliés qui n'appartiennent utilement à aucun maillage utilisez l'add-on [3D print toolbox], cliquez sur le bouton [Isolate] de la zone [Cleanup].


    Cette fonction ne supprimera que les arrêtes et vertices isolés. Si les objets à supprimer contiennent plusieurs faces, il faudra :


    
      	les supprimer manuellement avec [RMB];


      	[L] pour étendre aux arrêtes reliées


      	puis [X] pour supprimer.

    


    Angles aigus


    En cas d'angles trop aigus, vous retombez dans le cas de figure d'un manque d'épaisseur. Il faudra en général épaissir en générer de nouvelles faces qui pourront être ensuite déplacées. Cela modifiera bien sûr l'aspect de l'objet et il faut que cela soit possible.
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    Échafauder son maillage


    Les logiciels d'impression 3D sont tous capables de créer des supports automatiquement, mais cet automatisme n'est pas parfait car souvent cela double le temps d'impression. Dans le cas des imprimantes à plusieurs têtes, il sera possible d'imprimer l'échafaudage dans une matière, par exemple qui se dissout à l'eau.


    Ajouter manuellement dans Blender des supports aux endroits nécessaires reste donc une solution incontournable.


    Pour cet exercice, nous allons partir de la primitive de Blender, Suzanne, que l'on a pris soin de rendre manifold en fermant le maillage au niveau de ses yeux.


    [image: ]


    Grâce au [Mesh Analysis] (cf chapitre "Analyser son Maillage") en type [Overhang], vous pouvez repérer aisément les zones à soutenir. Elles seront représentées en couleur chaude allant du jaune au rouge. C'est évidemment en général dessous la forme qu'il faut regarder [Ctrl NumPad 7].


    [image: ]


    Pour créer cet échafaudage, désélectionnez tout [A] et ajoutez un cube sous le modèle, puis éditez-le pour supprimer 4 de ses faces afin de n'en conserver que 2.


    [image: ]


    En mode de sélection par arête, ajuster les dimensions de ces plans, dupliquez-en au besoin [Maj D], veillez à faire rentrer ces faces dans le modèle aux emplacements les plus marqués par le mesh analysis.


    [image: ]


    Dupliquez le plan central [Maj D] et séparez-le de l'objet [P]>Selection


    Revenez en mode objet, sélectionnez le nouvel objet et repassez en edit mode, faites le tourner sur l'axe Z de 90° [R]>[Z]>90


    [image: ]


    Comme pour les autres plans, placez à l'endroit les plus horizontaux du modèle (les zones les plus rouge du montré par mesh analysis, en mode overhang), en extrudant les arêtes verticales


    [image: ]


    Maintenant, il faut donner de l'épaisseur à ces deux objets, avec des modificateurs [Solidify] à 0.5 de [Thickness].


    [image: ]



    Ajoutez un modificateur [Boolean] en mode [Union] pour unir les 2 objets supports, et un autre [Boolean] en mode [Difference] pour soustraire la forme du modèle du support.


    [image: ]



    À ce moment vous avez deux choix, soit exporter votre support et votre modèle dans le même fichier Stl, soit si vous disposez d'une imprimante à double extrusion, exporter votre modèle et votre support dans 2 fichiers séparés afin d'imprimer le support dans une matière soluble.


    Dans le premier cas, sélectionnez les deux (clique droit sur le premier et shift clique droit sur le deuxième) puis exportez en Stl, dans le deuxième cas, exportez-les l'un après l'autre à l'aide de la fonction d'export du panneau [3D Print].
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    Exporter au format STL et OBJ


    Il existe deux grands formats d'export courants pour les maillages en vue de l'impression 3D : le STL et le OBJ. Le STL, pour STereoLithography, a été d'emblée conçu pour l'impression 3D et c'est lui qui sera utilisé dans la majorité des cas, car il ne mémorise que les informations géométriques nécessaires à l'impression. Le format OBJ sera utilisé dans des cas particuliers, plus évolués mais aussi plus rares.


    Dans tous les cas, il est conseillé de garder le modèle de base au format blender .blend qui permettra de retoucher beaucoup plus facilement au fichier.


    Préalablement à tout export, il faut penser à :



    
      	centrer l'objet à l'origine de la scène afin d'obtenir un objet centré à l'ouverture dans le logiciel générateur de g-code [Alt G].


      	Agrandir l'objet pour que ses dimensions correspondent à la taille voulue avec pour repère une unité blender égale à un millimètre.


      	Valider l'échelle de l'objet comme l'échelle de référence [Ctrl A>Scale].

    


    Exporter en STL


    L'exportation en STL va donc mémoriser le maillage sur forme de géométrique triangulée. Elle va permettre d'obtenir un modèle 3D standard à partir de notre document Blender, sans les éléments additionnels non nécessaires : textures, couleurs, animations... Ce fichier STL vous sera demandé lors d'une impression en ligne, ou lors d'une impression locale.


    Une fois la fonction d'export en STL activée, des options apparaissent dans la Toolbox :


    [image: parametre exportation STL]


    
      	Ascii


      	L'option [Ascii] permet de créer un fichier STL lisible dans un éditeur de texte.


      	Apply Modifiers


      	La case [Apply Modifiers] s'occupe d'appliquer les modificateurs influant sur la géométrie de l'objet pendant l'export. En théorie, les modificateurs ont déjà été appliqués avant la phase d'analyse et de nettoyage du maillage. En pratique, garder cette option active pour l'export d'un objet sans modificateurs ne peut pas nuire à l'export.


      	X, Y, Z


      	Le choix de la lettre indiquant l'axe de la hauteur est arbitraire dans les logiciels de 3D. La plupart du temps, l'axe choisi pour définir la hauteur est l'axe Z ou Y. Dans Blender, la vue de dessus (Top) est dans le plan YX et donc la hauteur correspond à l'axe Z. Blender peut alors être qualifié de logiciel en Z up. La vue de face (Front) est dans le plan ZX et donc la profondeur de cette vue correspond donc à l'axe Y.

      Vous devez changer les options Up et Forward pour adapter le fichier exporté au comportement du logiciel dans lequel sera ouvert le fichier STL.


      	Scale


      	La valeur [Scale] permet également de réduire ou d'agrandir la taille de l'objet exporté, si l'on connaît les préférences de la plateforme pour laquelle le .STL sera traduit en impression 3D. La plupart des logiciels d'imprimantes s'exprime en mm et considèrent pour une valeur Scale à 1 qu'une unité blender est égale à 1 mm.

    


    Si ces options sont ignorées, le modèle sera peut-être importé dans le mauvais sens avec une rotation de 90° ou trop grand ou trop petit . Cela n'a rien généralement de dramatique puisque quasiment tous les logiciels tiers d'imprimante ou plateforme d'impression en ligne offre généralement la possibilité de faire une rotation 90° ou une mise à l'échelle du modèle avant impression. Cependant, dans le cas d'un processus automatisé qui utiliserait directement le fichier .STL, il vous revient de tester et de définir une procédure à suivre.



    
      Le format .ply avec lequel Blender est compatible a été prévu pour résoudre certains défauts du STL mais n'est pas aussi utilisé.
    


    Exporter en OBJ


    Par rapport au STL, le format OBJ va permettre d'avoir plusieurs couleurs sur le modèle 3D. La plupart des méthodes d'impressions sont basées sur des matériaux monochromes, le STL sera alors largement suffisant. Mais il existe des imprimantes 3D à quadrichromie utilisées par les services en ligne et il est possible de penser qu'elles vont peu à peu se répandre.


    Le format .OBJ est un standard commun à la plupart des logiciels de 3D quel que soit leur domaine. Beaucoup d'options de l'export n'ont pas d'intérêt pour l'impression 3D.


    Pour exporter, il faut aller dans le menu Fichier > Exporter [File>Export] ce qui affiche le panneau spécifique, évidemment plus complet que celui du STL, puisque le OBJ inclut aussi des options plus utiles dans le rendu.


    [image: parametre exportation OBJ]


    Les options [Apply Modifiers], [Forward], [Up] et [Scale] sont les mêmes que celles décrites pour le format STL. Quelques autres options peuvent cependant se rendre intéressantes :



    
      	selection only


      	L'option [Selection Only] permet de limiter l'export aux objets sélectionnés dans la scène. Très pratique si vous ne souhaitez imprimer qu'une partie d'un ensemble sans vous battre avec chacune d'entre elles et enregistrer des fichiers intermédiaires..


      	triangulate faces


      	L'option [Triangulate Faces] change les faces quadrangulaires en triangles. Le triangle est la face de base pour toutes les machines. Mais un modèle uniquement composé de triangles est moins simple à comprendre pour un humain que pour une machine. Heureusement, chaque rectangle, carré ou losange peut être interprété comme deux triangles co-planaires. En théorie, le maillage doit être triangulé avant la phase d'analyse et de nettoyage.


      	write materials


      	Pour colorer votre modèle, il faut qu'il possède un matériau et une texture diffuse mappée selon des coordonnées UV. Souvent les plateformes d'impression ne supporte qu'une seule texture et un seul canal de coordonnées UVs [UVmap].

      Si vous souhaitez exporter de la couleur, cochez [Write Materials] et [Include UVs].

      Les propriétés du matériau seront stockées dans un fichier .MTL créé au même endroit que l'.OBJ.

      Si vous passez par un service en ligne, il vous sera alors demandé de transmettre l'.OBJ, le .MTL et le fichier image (.jpeg ou .png) correspondant à la texture dans une archive .zip.



      	
        Après avoir vérifié vos paramètres, et choisi un chemin pour votre fichier, renseignez le nom de celui-ci : [image: ]Puis cliquez sur le bouton Export OBJ.


      

    


    Vous obtenez ainsi votre modèle exporté depuis l'interface de base


    Exporter à partir du 3D Print
Pour un travail récurrent d'impression 3D, l'add-on [3D Print Toolbox] possède 3 lignes d'options qui permet de faciliter le travail d'export. Il aura l'avantage de prendre en compte la sélection uniquement et d'offrir un panel d'autres formats.

    [image: ]

    Le premier bouton reprenant reprenant l'icône du [Scale] sert à prendre en compte les unités de la scène lors de l'export.

    Le second bouton copie les fichiers des textures Image dans le même répertoire que celui indiqué pour l'export à la ligne en dessous.

    Par défaut, le format d''export est le .STL mais vous pouvez le changer pour un autre format (PLY,X3D,VRML2 ou OBJ).


    La ligne contenant les // permet de choisir le dossier d'export. Le nom du fichier exporté sera quand à lui basé sur celui du fichier blender.


    Ces préférences sauvegardées, une bonne fois pour toutes, la phase d'export ne se limitera plus qu'à appuyer sur le bouton [Export] à chaque fois que cela sera nécessaire.



    


  


  
    Où imprimer ?


    À présent que le fichier est soigné, il est prêt pour la prise en charge par la machine. Quelques services d'impression en ligne apparaissent aujourd'hui, aussi bien sur le web qu'au coin de la rue.


    Sur le web


    Les spécialistes



    Les incontournables du web marchand sont i.materialise, sculpteo, shapeways et cubify. Il s'agit ici de spécialistes offrant sur le web divers procédés et divers matériaux. La prestation est soignée, il en va de la réputation du "Cloud Printing", l'impression 3D déportée «en nuage» qui repose sur des plate-formes physiques, implantées sur tous les continents. Ces outils en ligne tendent à rendre le processus le moins douloureux possible pour l'usager, et l'expérience agréable. Un transfert de fichier et un calcul de prix selon le matériau et la dimension choisie, et l'affaire sera réglée et livrée sous quelques jours par la Poste, si besoin par transporteur. Les matériaux et les frais de port aidant, ces services sauront d'autant satisfaire l'utilisateur livrant un .stl impeccable car les "ratés" coûtent chers. Les formats supportés sont nombreux et varient selon les sites marchands. Le .stl et le .obj restent toutefois les plus universellement intégrés. Format supportés - http://www.shapeways.com/tutorials/supported-applications?li=nav


    capture d'écran objets différentes couleurs/ différents matériaux.



    Les matériaux sont plus ou moins les mêmes au menu des diverses offres commerciales. On retrouve les plastiques blancs ou colorés, et dont les propriétés vous offrirons divers niveaux de finition, l’Alumide, mélange de polyamide et de fines particules d’aluminium permettant d'obtenir des pièces particulièrement résistantes, les cires, par exemple pour les tirages "à la cire fondue" que l'on retrouve souvent en bijouterie, les résines, qui se destinent plus particulièrement aux rendus métallisés ou plaqués de métaux précieux par la suite. Certains vous proposeront aussi de la céramique (par émaillage à chaud d'une pièce imprimée). Il y en a pour tous les goûts et vous devriez pouvoir y trouver votre bonheur. Vous adapterez la résolution de votre modèle en fonction de la destination de l'objet final. Nul besoin de transférer un fichier aux millions de facettes s'il s'agit d'un tirage céramique, qui sera un peu lissé naturellement par le procédé utilisé.



    Les généralistes



    Sur le même modèle mais plus généraliste, vous trouverez le Néozélandais Ponoko, service de fabrication étendu qui propose, toujours depuis votre clavier et à l'international, découpe & gravure laser, impressions et même prototypage électronique. Son partenariat avec Formulor (DE), Vectorealism (IT) et RazorLab (UK) lui permet d'être présent en Europe, celui avec Sparkfun (US) ajoute au site la possibilité d'intégrer de l'électronique à votre projet. Son rapprochement avec le fabriquant de fraiseuses à commande numérique shopbot élargi encore son offre en proposant une communauté de plus de 600 professionnels capables de réaliser votre demande. L'idée de 100K Garage consiste à vouloir faire circuler des idées plutôt que des objets physiques, réalisés localement. De quoi savoir faire et le faire savoir...

La magie du web offre aussi le service http://www.3dhubs.com/#about. Le principe, dans les grandes lignes, consiste à mettre du temps d'impression sur le marché des utilisateurs. En référençant ses machines, autrui peut louer son service à un tiers, devenant le temps d'une impression, une sorte de mini usine. Ce choix pourrait aussi s'avérer judicieux pour produire rapidement et en quantité une pièce identique, en opérant de manière parallélisée. Imprimantes de tous les pays, unissez-vous !

    L'initiative nord américaine «100K Garages», un réseau décentralisé de professionnels ayant à disposition une fraiseuse numérique (bois principalement), permet d'offrir <<a decentralized network of shop-bot manufacturers in North America>>.


    La longue traîne des objets



    En explorant plus avant les sites web suggérés, vous remarquerez que certaines de ces plate-formes jouent pleinement des options ouvertes par le web et proposent aux auteurs de modèles 3D de devenir revendeurs de leur production imprimée. Grâce aux plus abouties de ces plate-formes, s'offre à vous la possibilité de vendre des objets embarquant même de l'électronique. Devrions nous parler d'artisanat à la sauce 2.0 ?



    En guise de dessert, le Sugar Lab saura peut être vous satisfaire. Reste à savoir si l'addition est aussi soluble que cette prestation est sucrée ?


    Au coin de la rue



    Pour celles et ceux que les nuages rebutent, des solutions pointent le bout du nez dans le monde physique. Depuis quelques temps sont apparus, pour le moins en France, des services d'impression grand public. Auchan, Top Office, et même La Poste testent depuis peu ce service auprès du public. L'offre est certes plus restreinte mais reste à un tarif abordable. Ici aussi, on teste le potentiel d'un marché auprès des consommateurs.


    Pour celles et ceux qui voudraient plonger plus avant et comprendre comment tout ceci fonctionne ou simplement pour acquérir un tour de main supplémentaire, rendez-vous est pris :


    
      	dans les Fablabs, LABoratoires de FABrication souvent associatif et parfois public, mixant le numérique et les savoirs manuels pour le plaisir et la progression de tout un chacun;


      	dans les Makerspaces, Laboratoires parfois associatifs, parfois informels, souvent activiste, où l'improbable peut prendre libre forme et engendrer l'étincelle amusante;


      	dans les Techshops qui devraient prendre place, centres commerciaux de ressources matérielles, où l'abonné peut réaliser des prototypes à la pointe de la technologie.

    


    Quelle que soit la saveur, ces lieux plus ou moins marchands sont autant d'opportunités offertes à celui qui cherche à envisager le numérique et la fabrication autrement.


    Il s'agit là avant tout de se réapproprier et de concilier le savoir et le faire, numérique ou pas, l'impression 3D offrant un outil supplémentaire pour explorer cet univers qui s'offre à vous.



    Chez soi


    Depuis mars 2005 et l'ouverture du blog, le projet RepRap (contraction de "replicating rapid prototyper" que Wikipedia France propose de traduire par «concepteur de réplication rapide») à fait beaucoup de chemin, et surtout beaucoup d'émules.


    Initié à l'origine par Adrian Bowyer et l'université de Bath pour étudier l'évolution des machines capables de se répliquer elles mêmes, ce projet Open Source à généré une multitude d'adaptations de la part de sa communauté d'utilisateurs/trices. On trouve en effet aujourd'hui une multitude de variantes, commerciales ou non, plus ou moins abouties, plus ou moins performantes, mais qui toutes répondent à un besoin spécifique. Ces variantes permettent d'envisager l'extrusion 3D sous divers angles. Certaines d'entre elles sont spécialisées dans l'impression grand format (LeBigRep), d'autre sont pliables (Foldarap) pour être facilement transportables, certaines impriment avec du chocolat (Choc-Creator), du sucre (CandyFab) ou proposent tout simplement une électronique plus avancées que la moyenne (Asimov).


    Certaines n'existent pas en kit et ne verront le jour que si vous décidez de les fabriquer à partir des sources et des plans mis à disposition par les concepteurs, ou si un particulier particulièrement enthousiaste se décide à vendre des pièces sur un site web marchand. Malgré le temps consacré à l'achat des divers matériels ainsi qu'à l'assemblage, cette option reste cependant la meilleure façon d'appréhender la richesse de l'impression 3D Open Source et de faire de substantielles économies.


    Enfin, certaines machines sont livrées chez vous en kit, d'autres encore vous parviennent prête à l'emploi. Parmi cette multitude, on trouve des projets dont l'objectif est de faciliter la prise en main de ces outils par le grand public, les impatients ou les plus fortunés. Citons parmi les plus connues les exemples de la Makerbot, de l'Ultimaker, du Cube ou encore les prochains modèles Form1 ou Bucanneer. Pour 2 à 3 milles euros selon les versions, les options ou les techniques employées, vous pourrez vous offrir à domicile les services de ces machines clairement orientées vers la facilité d'utilisation.


    Concrètement, comment cela se passe-t-il avec sa propre machine ?


    Pour illustrer le propos et vous donner un aperçu qui vous permettra de vous situer par rapport à vos besoins, nous détaillerons la procédure complète d'impression sur une suite logicielle. Repetier et son compagnon Slic3r, un logiciel qui vous permettra de gérer l'importation du .stl, sa conversion en gcode, puis son transfert vers la machine.
[image: ]


    Slic3r est un logiciel de création de G-code, il calcule les trajets de la tête d'impression et le débit de plastique.

    Vous devez le configurer selon les paramètre de votre machine, la taille de son plateau, le diamètre du filament, le type de plastique etc.

    Une fois correctement configuré, il est très simple à utiliser et rapide pour générer du Gcode. Vous n'avez qu'à ouvrir le Stl, cliquer sur "Export G-Code..." et attendre qu'il le génère.


    Une fois le G-code produit, vous devez utiliser Repetier (ou un autre logiciel pour contrôler votre machine).


    


    [image: ]


    Repetier permet de visualiser le chemin créé par Slic3r et l'envoyer à l'imprimante, il gèrera la chaleur de l'imprimante, le déplacement de la tête et le débit du plastique d'après le G-code.



    En Conclusion


    Sur le fond, il n'y a rien de vraiment neuf sous le soleil. La couche numérique n'apportera rien à votre projet si vous ne respectez pas les formalismes minimaux qui permettent à tous d'échanger des fichiers. Si vous n'y accordez pas un peu de "logique métier", autrement dit. Quel que soit le logiciel et la machine choisie, l'attention apportée à la fois à votre fichier.stl et au paramétrage de vos réglages d'imprimantes, vous ouvrira les portes d'un Eldorado qu'à condition que vous livriez un plan en bonne et due forme à vos interlocuteurs. Comme un architecte livre un plan parfaitement coté à un charpentier, finalement.


    Pour ceux qui aime les dernières avancées, nous vous conseillons de suivre l'actualité du projet ambitieux Peachy Printer. Cette imprimante devrait devenir la moins chère du marché car elle n'a aucune électronique embarquée, tout est géré par l'ordinateur sur lequel le boîtier de la Peachy est relié. Son pilote devrait être un simple addon pour Blender.


    

  


  
    Glossaire


    Ce glossaire est là pour vous expliquer les termes employés dans ce livre.


    
      	Add-on


      	Morceau de logiciel permettant d'enrichir les fonctionnalités d'un programme donné (ici Blender). On pourrait aussi parler de plugin, ou d'extension. Dans Blender, certains Add-on sont activés par défaut et d'autres non.


      	Mesh, Maillage


      	Le mot maillage est utilisé pour parler d'un objet 3D du point de vue de constituants techniques particulier rendus par une multitudes de points reliés les uns au autres, un peu comme un filet. Le maillage est une forme majeure de la modélisation 3D qui contient aussi d'autres types d'élément comme les courbes de bezier, les NURBS...


      	CAD


      	Computer Aided Design CAD est le sigle anglais pour la Conception Aidée par Ordinateur CAO. De fait, les noms des logiciels de CAO sont souvent anglais et incorpore le sigle anglais dans leur nom: FreeCAD, QCAD, OpenSCAD, HeeksCAD ...



      	SVG


      	Le SVG, scalable vector graphics, est un format d'image vectorielle. Il est une recommandation du W3C, même organisme qui gère le développement du langage HTML.


      	Extruder


      	Extruder est un procédé de fabrication consistant à donner forme à un objet. En 3D, il définit plus particulièrement le fait de produire de parties d'objet (vertex, arrêtes, faces) à partir d'autres existantes par une copie qui sera liée aux originales.


      	Libérathon


      	Mot-valise associant liber- (origine des mots «livre» et «libre») et -athon (de «marathon») désignant la méthodologie développée par Floss Manuals francophone pour écrire un livre collaboratif en un temps restreint.


      	Support matériaux


      	Dans les logiciels vous trouverez des fonctionnalités que l'on peut traduire indifféremment par support matériaux, supports d'impression ou encore échafaudage. Cela désigne tous les ajouts réalisé afin de faire en sorte que l'impression puisse se réaliser sans que l'objet se casse sous son poids. Après l'impression, il est donc nécessaire de les supprimer pour délivrer l'objet.


      	BUGParis


      	Blender User Group de Paris. Groupe d'utilisateurs se réunissant autour du logiciel 3D Blender à Paris chaque premier samedi du mois.


      	Modificateur


      	Un modificateur est un outil de Blender permettant d'agir sur un maillage de façon dynamique. Il tient son nom du fait qu'il modifie la forme et recalcule sa modification au fur et à mesure de la modélisation.


      	Vertex


      	Point ou sommet d'un maillage


      	Manifold


      	Volume fermé. Il sera plus souvent question de maillage non-manifold, non-fermé à cause des problèmes qui peuvent en découler dans la structure.


      	NGon


      	Face formée de plus de 4 vertices. Pour retrouver des faces classiques dans Blender, il faudra utiliser les raccourcis [Ctrl T] ou [Alt J].

      [image: ]



      	Normal


      	Une normale est un vecteur perpendiculaire à une face ou un vertex. Dans Blender, on les utilisera pour visualiser l'orientation de la face. Pour les afficher il suffit d'aller dans le panneau [Mesh Display] des Propriétés [N] et d'activer l'affichage des Normales à afficher ainsi que leur longueur.

      [image: ]
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